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Parker Automation Controller QuickStart

Compax3 

• Device Selection

• I31T11 Drive Configuration

• EtherCAT & DS402 settings

EtherCAT connections

PAC

• Launch PAC software

• Start a Standard Project

Connecting to PAC

Introduction

This shows step-by-step instructions how to configure and setup a Parker Automation Controller 

with a Compax3 EtherCAT servo drive, import a simple program and get motion quickly.  These 

instructions show screen captures of the PAC Integrated Development Environment (IDE) 

software and C3 ServoManager to help show these steps.  The first step is to configure the 

Compax3 using the C3 ServoManager software and setting the EtherCAT & DS402 parameters.  

The second part is to start the PAC IDE, auto scan for the EtherCAT devices and set the 

EtherCAT network parameters, import a sample program and then download & run.

• Connecting to PAC

• Discover EtherCAT devices

• Add SoftMotion Axis 

• Rename SoftMotion axis 

• Rename Axis & Set Scaling

• Parker Motors & Mechanics

• Set EtherCAT Master Task to External

• Set EtherCAT_Master Distributed Clock

• Set Compax3 EtherCAT

• Download & Import Sample Program

• Organize Project

• Set Distance/Velocity/Accel

• Build (F11)

• Login / Download

• Start PAC Application (F5)

• Watch List

• Online Monitoring & Stop Application

• Application in Stop & Reset Cold

2

www.comoso.com



Parker Automation Controller QuickStart

Device Selection

� Launch C3 Servo Manager

� Double-click on Device Selection Wizard

Purpose

This document describes how to start a new application with the PAC and get 
basic motion with the PAC with a Compax3 EtherCAT servo drive.
First we’ll show how to configure the Compax3-I31 for the PAC.
Then we’ll show configuring the PAC using the PAC IDE software. 
For PAC users that are using the PLC only version (PAC320-P), skip to page 
16.

� This will launch the wizard that allows you to 

select the appropriate model

� Screen 1: SxxxVx or MxxxD6 or HxxxV4

(select your power level)

� Screen 2: Fxx (select your feedback type)

� Screen 3: I31 (Choose I31 for EtherCAT)

� Screen 4: T11 (Choose I11)

� Screen 5: M00 (Choose M00 for no options)

� You will end up with a part number that looks like: 

S063V2F12I31T11M00 and should match the label 

on the side of your drive
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Parker Automation Controller QuickStart

Drive Configuration

� Double-click on “I31T11 Drive Configuration”

� The Drive Configuration Wizard opens and 

you will need complete 16 steps – though only 

a few need input.

Step 1: Motor Selection

� You will need to select the motor you are using� You will need to select the motor you are using

� See the picture below to see how the BE23 motor is found:

� Click “Next”

Parker US

BE23

Model
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Parker Automation Controller QuickStart

Step 3: Motor Selection

� Select the Parker part number for braking resistor 

Step 2: Motor Reference Data / PWM Settings
� This step needs no input from you

� This data is populated from the motor files

� Click “Next”

• The Compax3 already has 
internal braking resistance, 
however, if your needs 
exceed the braking 
capabilities, you may need 
to use a Parker BRM 
breaking module.  See 
manual for recommended 
combinations.

� Select the Parker part number for braking resistor 

using – or enter the user defined value

� Ignore this screen if not using a resistor

� Click “Next”
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Parker Automation Controller QuickStart

Step 5: Moment of Inertia

� This is the most important tuning 

step

� The Compax3 uses this for 

gains.

� The closer you are to the 

correct inertia of your load, 

the better your system will be 

tuned.

� Suggestion: Use the value 

from MotionSizer.

� Enter the same load value in both 

the “Minimum” and the “Maximum” 

locations.

� Only if your load isn’t 

changing

� If load changes (example 

picking up a box, then 

placing box) enter “Min” and 

Step 4: This step is omitted 

placing box) enter “Min” and 

“Max” respectively. 

� “External Interia is unknown”

� Do not check the box – if you 

do, call Parker Applications 

Engineering for help with this 

AutoTuning Feature.

� Or see free Video training:

www.parkermotion.com >

FAQ > Compax3 > 

VIDEO: How do I tune a 

Compax3? (auto-tune) 

� Click “Next”
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Parker Automation Controller QuickStart

Step 6: Distance / Travel Parameters
� Select INCREMENTS for units of travel

� Travel Distance per revolution: Use Motors post-quadrature Encoder or Resolver 

resolution

Note: See page 25 for feedback resolution based on motor model number

� Travel Distance per revolution-Denominator: This should always be 1

This is because the PAC’s setpoint is an integer value.

� The other fields can be left at the default as shown.  

� Motor direction can be reversed by setting Invert Motor Rotation/Direction Sense. 

Default motor direction is clockwise looking at the motor shaft or for IForce or 

Ripped linear motors, extending away from the cable entry.
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Step 7: Machine Zero / Homing

� Set drive Homing Mode

� Use Homing Mode Wizard to select 

different options:

� Z-pulse/encoder reference

� Home sensor 

� Limit sensor

� HardStop 

� PAC tells the Compax3 to start 

homing and the C3 tells the PAC 

when homing is complete

� Click “Next”

Step 8: Travel Limits / Settings
For rotary applications without limits

� Positive SW:  0 - No response

� Negative SW: 0 - No response

� Positive HW:  0 - No response

� Negative HW: 0 - No response

� All boxes unchecked

For axis with limits

� Positive SW:  0 - No response

� Negative SW: 0 - No response

� Set soft limits in PAC

� Positive HW:  1 - Stop, energized

� Negative HW: 1 - Stop, energized

� PNP NC: Set active low is unchecked

� NPN NC:  Set active low checked 

(Requires  4.7k pulldown resistor)

� Click “Next”
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Parker Automation Controller QuickStart

Step 10: Monitoring / Limit Settings

� Current Limit: Select as a percentage of motor continuous

� Set Tracking Error – Set value

Step 9: Jerk / Ramps
� No changes required, leave 

as default

� PAC controls these values

� Click “Next”

� Set Tracking Error – Set value

� Set in increments

� Suggested value: 1 rev or 25mm

� Other values as default settings

� Click “Next”
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Parker Automation Controller QuickStart

Step 11: Encoder Output

� This can be left in the default state.

� Select “ON” if you want to 

send out the motor encoder 

through the X11 connector 

on the Compax3

� The EtherCAT Cable automatically 

sends the encoder/resolver position 

to the PAC.

Step 12: I/O Assignment

� Make sure the I/O assignment is select “Free”

� This gives the PAC control over all I/O.

� Click “Next”
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Parker Automation Controller QuickStart

Step 13: Position Profiles - Configuration

� There is nothing to be done here.

� Click “Next”

Step 14: Profile Table

� This is where you would select the various 

profiles called up by a PLC or digital I/O.

� There is nothing to be done here because the 

PAC controls all positioning.

� Click “Next”

11
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Parker Automation Controller QuickStart

Summary Configuration: “Your Part Number” 

� The Top Middle should be green; this means 

that the setup is done.

Step 15: Other Error Reactions
� Default settings are shown 

and recommend for most 

applications

� Highlight the field to reveal a 

pull-down to change the error 

reactions if needed 

� Click “Next”

that the setup is done.

� You can name your configuration.

� You can add notes to your configuration.

� Click “Finish”

• You could download 
your configuration 
here, but we have to 
setup the EtherCAT.  
You will save time if 
you just click “finish”. 
This will bring you 
back to the main 
C3ServoManager 
Screen.
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Communication > EtherCAT

� SLAVE with CoDeSys V3 SoftMotion

The EtherCAT portion of the setup is very simple. 

There are two steps:

� Set the EtherCAT Mode

� Set the DS402 scaling

EtherCAT & DS402 Scaling settings

Communication > DS 402 / scaling setting

� Change the Y4 scaling interpol pos setpoint to 10^0 (1)

� Change the Y4 scaling actual position to 10^0 (1)

13
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Parker Automation Controller QuickStart

Download Drive configuration

Download PC > Compax3

or Red down arrow icon on 
toolbar

Possible Errors
� Problem 1:

� Red Error Screen, check to see if correct COM port is selected

Options :  RS232/485 Com Port Settings

� Problem 2:

� Can’t Initiate Download: 

1. Check to make sure 24volt power is on

2. SSK1/02 cable is being used

3. USB-RS232 adapter with FTDI chipset required. 

Cables Unlimited USB2920 available on amazon.com 

� For more information:

� http://www.parkermotion.com/support.htm

FTDI chipset
inside
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Parker Automation Controller QuickStart

X1

EtherCAT Connections
� S24 Address dipswitches on C3 are not used.

� PAC auto addresses EtherCAT slaves based on order they’re connected.

� PAC IDE application needs to match this order. This is set when the 

EtherCAT scan is done (page 20).

� S24 lights will not start until the EtherCAT netowrk is started.

� Ethernet cables can be standard or patch type.

� Do not use switches or hubs on the EtherCAT network.

X23 IN

X24 OUT
X23 IN

X24 OUT

X23 IN

X24 OUT

X23 IN
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Launch PAC software 

• Start Parker Automation Controller Integrated Developer Environment (IDE)

• Click New Project…  or go to File > New Project

16
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Start a Standard Project 

• Select Standard project, name the project and set location

• Change Device to PAC320-?xx2x-xx(Parker Hannifin) 

? is C, M or P based on your model number (on side of PAC320)

The PLC_PRG language type can be left as Structured Text (ST)

17
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Connecting to PAC 

• Now there’s Device, Application, EtherCAT_Master and PAC320_BusCoupler.

• In Devices window, Double-click on Device (PAC320-?xx2x-xx).

To view Devices, Goto: View >  Devices

Under the controller, Type: 192.168.10.50 and press enter.

18
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Parker Automation Controller QuickStart

Connecting to PAC 

•      The green light on the PAC icon indicates connected.

Problems connecting?

1. Make sure your PC’s ip address is set to 192.168.10.x 

where x is something other than 50

THE SUBNET HAS TO BE 255.255.0.0

2. The PC should be connected to the PAC’s  X2 Ethernet port.

PAC supports both straight and patch cat5 cables.

For how to set your PC's Ethernet IP address:
� http://www.parkermotion.com/support.htm

19
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Discover EtherCAT devices 

• Right-click on EtherCAT_Master

• Click Scan For Devices…

• This will auto-detect the PACIO   

modules and any other EtherCAT

devices.

20
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Discover EtherCAT devices 

• Scanned Devices appear.

• Click Copy all devices to project.

• Devices window will update showing the EtherCAT devices:

• PAC320-P users can skip to page 35

21
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Rename SoftMotion axis 

• Change the 

SM_Drive by clicking 

to highlight the 

name.  Then click 

SM_Drive again…

(Double click will 

open the SoftMotion

tabs.)

…and rename it  X

22
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Rename Axis & Set Scaling

• This will triggers a refactoring. Click Yes and OK.

• Double-Click on X, then SoftMotion Drive: Scaling/Mapping tab

• Change the scaling to the motor’s resolution. 

• This will set distance motor revs. Set mechanics scaling (optional, next 8 pages).

23
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Parker Motors & Mechanics

The PAC allows users to program moves in user units. 

Scaling for each axis is located on the SoftMotion Drive: Scaling/Mapping tab.  

Scaling is set by 3 steps:

1. Defining the motor’s feedback resolution/increments.

2. Input the gearhead ratio

3. Input the ratio for application units (numerator & denominator).

Parker motors are offered with a wide range of feedback types and 

resolutions.  Gearheads and linear actuators & stages are offered a wide 

range of leads and ratios. The order codes and the actual leads are listed on 

the next few pages for reference. 

24
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Parker Rotary Motors

Step 1.

Set the increments per motor turn.

The drive should be set the same.

Parker motor part number’s order code designates 

this and is shown on the right.

Below is set for a BE motor with J encoder 8000ppr.

Series Order 
Code

Feedback

resolution

MPE 4E 10000

X custom

MPP 1E 8000

MPJ 41 4096

MPW 6S 32768

9S 32768

7D or 8D 524288

X custom

BE J 8000

R 4096

L 20000

X custom

SM E 4000

R 4096

L 20000

J 8000

X custom

N E 4000

J R 4096

X custom

MPM G 4096

JN 8000

other See 
catalog

SMN 2S 8192

41 4096

5D 32768

25
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Parker Gearheads Series Order 

Code

Gear Ratio 

(exact)

PS

PX

PV

RS

RX

PG/RA

NE/NR

001 1:1

003 3:1

004 4:1

005 5:1

007 7:1

008 8:1

010 10:1

012 12:1

015 15:1

016 16:1

020 20:1

025 25:1

Step 2.

Set the motor turns per gear output 

turns.

Parker gearhead part number’s order 

code designates this and is shown on 

the right.

Parker gearheads are exact ratios. 

Thus the gear output turns will always 

be 1.

Below shows setting for a 3:1 

030 30:1

035 35:1

040 40:1

050 50:1

070 70:1

100 100:1

Below shows setting for a 3:1 

gearhead.

If the system doesn’t use a gearhead, 

leave this set to the default (1:1).

26
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Parker Automation Controller

Parker Mechanics

Parker Mechanics

Step 3.

Set the gear turns per application units.

Parker actuators & stage part number’s 

order code designates this and are 

shown on the following pages as well 

as the ratios for both inches and 

millimeters.

As an example, below shows setting for 

a ET with B05  in millimeters.

27
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Parker Mechanics

Order mm in

Series Code Lead denominator numerator denominator numerator

HD D02 5mm 1 5 254 50

D03 10mm 1 10 254 100

D04 20mm 1 20 254 200

D07 40mm
1 40 254 400

XR, XE D2 5mm 1 5 254 50

D3 10mm 1 10 254 100

D4 20mm 1 20 254 200

D5 25mm 1 25 254 250

D6 32mm 1 32 254 320

D9 2mm 1 2 254 20

D31 1mm 1 1 254 10D31 1mm 1 1 254 10

D32 2mm 1 2 254 20

D33 5mm 1 5 254 50

D34 0.10 inch 100 254 10 1

D35 0.10 inch
100 254 10 1

ET A04 0.250 in 100 635 4 1

A05 0.200 in 100 508 5 1

A08 0.125 in 1000 3175 8 1

B01 1.000 in 10 254 1 1

B02 0.500 in 10 127 2 1

B04 0.250 in 100 635 4 1

B05 0.200 in 100 508 5 1

B08 0.125 in 1000 3175 8 1

B53 1.875 in 1000 47625 8 15

M05 5mm 1 5 254 50

M10 10mm 1 10 254 100

M20 20mm 1 20 254 200

M50 50mm
1 50 254 500
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Parker Mechanics

Series Order 
Code

Distance mm in
per rev

denominator numerator denominator numerator

LCR BLT 44mm 1 44 254 440

30 58mm 1 58 254 580

LN02 2mm 1 2 254 20

LN10 10mm 1 10 254 100

ETH M05 5mm 1 5 254 50

M10 10mm 1 10 254 100M10 10mm 1 10 254 100

M16 16mm 1 16 254 160

M20 20mm 1 20 254 200

M32 32mm 1 32 254 320
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Parker Mechanics

OSPE 
Series

Order    
Code

Distance
mm in

per rev
denominator numerator denominator numerator

BHD 20 125mm
1 125 254 1250

25 180mm
1 180 254 1800

32 240mm
1 240 254 2400

50 350mm
1 350 254 3500

B 25 60mm
1 60 254 600

32 60mm
1 60 254 600

50 100mm
1 100 254 10001 100 254 1000

SB 25..3 5mm
1 5 254 50

25..4 10mm
1 10 254 100

32..4 10mm
1 10 254 100

25..5 25mm
1 25 254 250

32..5 25mm
1 25 254 250

50..5 25mm
1 25 254 250

ST 25 4mm
1 4 254 40

32 4mm
1 4 254 40

50 6mm
1 6 254 60

BV 20 108mm
1 108 254 1080

25 160mm
1 160 254 1600
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Parker Mechanics

HMR Order    
Code

Distance
mm in

per rev
denominator numerator denominator numerator

S

Ball
Screw
Drive

05 5 mm
1 5 254 50

10 10 mm
1 10 254 100

12 12 mm
1 12 254 120

16 16 mm
1 16 254 160

20 20 mm
1 20 254 200

25 25 mm
1 25 254 250

32 32 mm
1 32 254 320

32 32 mm
1 32 254 320

B

Belt 
Drive

08 66 mm
1 66 254 660

11 90 mm
1 90 254 900

15 BD or DD 100 mm
1 100 254 1000

15 AP/CP/AD/CD 125 mm
1 125 254 1250

18 BD or DD 130 mm
1 130 254 1300

18 AP/CP/AD/CD 150 mm
1 150 254 1500

24 BD or DD 160 mm
1 160 254 1600

24 AP/CP/AD/CD 224 mm
1 224 254 2240
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Set EtherCAT_Master Distributed Clock 

• Double-click on EtherCAT_Master (PAC320 EtherCAT Master)

• Set Cycletime to 2000us (and press ENTER)

• Set Sync Offset to 50%

• Enable Sync Window Monitoring and set to 100us

32
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Compax3 EtherCAT  settings

• Double-click on Compax3_EtherCAT_DS402_CoE

• This shows the slave settings for the Compax3.

• Do not need to change these.

33

• This should match the DC setting from previous step.

• IF IT DOESN’T MATCH, REPEAT PREVIOUS STEP.
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Set EtherCAT Master Task to External

• Under Task Configuration, double-click on EtherCAT_Master

• Change the Type from Cyclic to External

• Do not change interval

• Interval should already match our EtherCAT Master setting of 2000us

• If not, go to EtherCAT_Master device setting (page 32)

• The External Event will be EVEN_ECM_DC which is the Distributed 

Clock.

• It should look like this:

• Delete PLC_PRG from application and MainTask

34
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Download & Import Sample Program 

• Download sample program export

http:// www.parkermotion.com/PAC

• Download QuickStart sample programs (.zip) and unzip the .export files

35
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Download & Import Sample Program  

• Click on Application

• Project > Import…

36
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Download & Import Sample Program  

For the PAC320-M or PAC320-C, use RunMotion_X.external

For the PAC320-P, use Counter.external

• Click OK to import

• If you see this, click on Application and you should see above.

37
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Organize Project 

• Hold Ctrl key

• Select IO_AxisControl

and RunMotion_X

• Drag them into POUs 

and drop them onto 

project name  (QuickStart

in this example)

• For the PAC320-P, drag 

Counter into QuickStart.

To keep projects clean as users develop POUs (programs, function blocks and 

functions) organize them in POUs.  

38

• This keeps from cluttering the Devices window.

• For applications with more than one device, allows ONE location to 

make changes, rather than having to maintain copies under each 

device.

• Folders can be created for grouping the parts of the program for 

different machine functions.

• External files can also be imported into POUs for drawings, 

ECOs/version control, docmentation, etc.
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Organize Project  

• Motion must be in the EtherCAT task!!!

• Right-click on EtherCAT_Master

• Add Object > Program call…

• PAC320-C and PAC320-M users: Delete MainTask

• PAC320-P: Add Program call… in Main Task instead of EtherCAT_Master

39
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Organize Project  

• Either type RunMotion_X, or…

For PAC320-P users, type Counter

• Click the … 

• Select from Input Assistant

40
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Organize Project  

• PAC320-C or PAC320-M projects should look like this:

41

• PAC320-P projects should look like this: 
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Set Distance/Velocity/Accel 

• RunMotion_X program will enable the Compax3 drive, home and then 

extend and retract.

• g_PosDistance is the extend incremental distance.

• g_NegDistance is the retract incremental distance.

• g_Vel is the speed/velocity for both moves.

• g_Acc is the acceleration/deceleration for both moves.

• Set the Distance, Speed and Acceleration to appropriate values for your 

motor and mechanics in the Global Variable List (GVL): 

For PAC320-P users, skip this step. The counter program will increment a 

variable. Proceed to next page to compile.
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Build (F11) 

• Build > Build (F11)

• Message window on bottom should have 0 Errors
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Login / Download 

• Online > Login

• Or, click Login icon on toolbar

• On first time, it’ll warn that Application doesn’t exist.

• On subsequent logins, if the Application has changed or if PAC is running, 

it’ll  give a warning.

44
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Start PAC Application (F5) 

• Now online, click Start or F5 to run application

• EtherCAT devices will start green circular arrows and program starts running.

• RunMotion_X:This will enable the motor, home and then extend and retract. 

45

• Counter: This increment a CounterPLC variable every 1 second. 
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Watch List 

• To add variables to a Watch list, go to View > Watch > Watch 1

• Right-click on variables within the program and select Add Watch• Right-click on variables within the program and select Add Watch
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Online Monitoring & Stop Application 

• To stop PAC application, click Stop
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Application in Stop & Reset Cold 

• An application in stop, stops updating variables and the EtherCAT slaves 

will be greyed circular arrows.

• To restart, Online > Reset cold.  This re-initializes all variables and slaves. 

Then click Start to run again.
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Application in Stop 

• After Reset Cold, Application is in [stop] until Start (F5)

Orange/red triangles are normal in this state.
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Questions or Comments?    Email emn_support@parker.com
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